USER’S GUIDE

Tectonics from Digital Elevation Model
(TecDEM Version 1.0)

Faisal Shahzad
Remote Sensing Group
Freiberg University of Mining and Technology,
Freiberg, 09599, Germany.
www.rsg.tu-freiberg.de

Supervised By: Prof. Dr. Richard Gloaguen
Acknowledgements

This work is partly financed by the Graduate Student Research Grant (GRSG) from International Association of Mathematical Geosciences (IAMG) and funds from Government of Saxony (Germany).
# Contents

## Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td><strong>Introduction</strong></td>
<td></td>
</tr>
<tr>
<td>1.1 Motivation</td>
<td>5</td>
</tr>
<tr>
<td>1.2 Data Flow Diagram</td>
<td>5</td>
</tr>
<tr>
<td>1.3 Starting TecDEM</td>
<td>6</td>
</tr>
<tr>
<td>1.4 Data Handling</td>
<td>7</td>
</tr>
<tr>
<td>1.4.1 Importing DEM</td>
<td>7</td>
</tr>
<tr>
<td>1.4.2 Opening Project</td>
<td>9</td>
</tr>
<tr>
<td>1.4.3 Export Results</td>
<td>9</td>
</tr>
<tr>
<td>2</td>
<td>11</td>
</tr>
<tr>
<td><strong>Drainage Network Preparation</strong></td>
<td></td>
</tr>
<tr>
<td>2.1 Flow Directions and Link file</td>
<td>12</td>
</tr>
<tr>
<td>2.2 Upslope Area</td>
<td>12</td>
</tr>
<tr>
<td>2.3 Stream Strahler Orders</td>
<td>12</td>
</tr>
<tr>
<td>2.4 Sub Basins extraction</td>
<td>12</td>
</tr>
<tr>
<td>2.5 Plots</td>
<td>13</td>
</tr>
<tr>
<td>2.6 Streams Selection</td>
<td>14</td>
</tr>
<tr>
<td>3</td>
<td>17</td>
</tr>
<tr>
<td><strong>Analyses</strong></td>
<td></td>
</tr>
<tr>
<td>3.1 Stream Profile Analysis</td>
<td>18</td>
</tr>
<tr>
<td>3.2 Spatial Statistics</td>
<td>19</td>
</tr>
<tr>
<td>3.3 Basin analysis</td>
<td>20</td>
</tr>
<tr>
<td>4</td>
<td>23</td>
</tr>
<tr>
<td><strong>Reports</strong></td>
<td></td>
</tr>
<tr>
<td>4.1 Detailed and Tabulated</td>
<td>23</td>
</tr>
<tr>
<td>4.2 Profile Plots</td>
<td>23</td>
</tr>
<tr>
<td>4.3 Map Plots</td>
<td>24</td>
</tr>
<tr>
<td>4.4 Citations</td>
<td>24</td>
</tr>
</tbody>
</table>
Chapter 1

Introduction

Digital elevation models (DEM) are replacing traditional topographic maps in geosciences with the advent of space technology. There are different freely available DEMs GTOPO30, SRTM, ASTER GDEM and etc. The development of image processing techniques have provided us with the automatic drainage network extraction using DEMs. It is observed that the drainage responds rapidly to tectonic changes and thus it is a potential parameter for tectonogeomorphological analysis. Thus the spatiotemporal change in contributing area, elevation can reveal important information about the neotectonics in any area. The resolution of the DEMs can effect the results vary easily e.g. the high resolution DEMs can preserve regional and residual tectonic signal.

1.1 Motivation

At the Remote Sensing Group (RSG) and Tectonophysics Group, major emphasis is in understanding the tectonics and structuration in active regions, especially in Pamir, Tibet, NW Himalayas (Pakistan) Ethiopian Rift, Jordan, Eastern Cuba, Iceland and Erzgebirge Mountains (Germany). It is observed that there are plenty of software available for drainage extraction and then different geomorphological analysis. But due to the specific demand it was decided to create a new toolbox in MATLAB which can perform not only the previously available methods but also incorporates newly developed methodologies. In the present version, we provide information about drainage network preparation, stream profile analysis, surface dynamics and basin analysis. Soon in the new version we plan to add plenty of nonlinear analysis especially Fractal dimension, lacunarity, succolarti of drainage system.

1.2 Data Flow Diagram

The data flow diagram (DFD) of TecDEM 1.0 is show in (figure No. 1.1). Current release has been tested under MATLAB release 2009a and additionally it requires Mapping Toolbox. It has been extensively tested under MacOS, Windows and Linux based systems. The digital elevation model serves as an input parameter for this DFD. It first extract the drainage network using D8 algorithm. This extracted drainage network consists for streams as a function of spatial location with elevation and contributing area.
CHAPTER 1. INTRODUCTION

1.3 Starting TecDEM

The distribution of zip file called TecDEM.zip. First unzip this folder to an appropriate location in your computer. This folder consists of few sub folders and a main file called as TecDEM. They all consists of m or p files depending upon the distribution. Now start MATLAB and set your MATLAB path to all these folders. It is shown in Figure No. 1.2.

Figure 1.2: Starting TecDEM from MATLAB

Make it sure that you brows to TecDEM folder and then click on ok. This step will show the TecDEM directory structure in the Current Directory sub window. After that, on the command line just type

```matlab
>> TecDEM
```

TecDEM: Tectonics from Digital Elevation Model: User’s Guide
1.4. DATA HANDLING

It will pop up TecDEM graphical user interface consisting of different menus as shown in figure no. 1.3. This GUI also maintains activity log of the function you have executed. This log can also be saved by selecting Save Activity Log from File Menu.

![Figure 1.3: Main Menu of TecDEM](image)

**1.4 Data Handling**

**1.4.1 Importing DEM**

We provide basic data handling function for the import and export. The data can be imported in geotiff format. This can be done by accessing Import DEM from file menu. A new window will open asking the user for browsing to the desired DEM file as shown in figure no. 1.4. When a user imports DEM, a `*INFOMAT` file is automatically, where `*` is the default name of current project and is the same as the name of input DEM.
CHAPTER 1. INTRODUCTION

Figure 1.4: Importing Digital Elevation Model

Figure 1.5: Opening an existing project of TecDEM
1.4. DATA HANDLING

1.4.2 Opening Project

Other data handling function of TecDEM includes opening of existing projects and exporting the results. One big advantage of this software is that it automatically takes the backup of all the processes you are running and you don’t need to save them by yourself. To open an already processed data set, you need to click on open project menu from File menu and a window will appear as shown in figure no. 1.5. By opening an existing project, you will return to the last saved state of that project.

1.4.3 Export Results

The third data handling function is about exporting your results for further use. It can be accessed using Export function from File sub menu as shown in figure no. 1.6. Here, we provide the possibility to export both raster and vector data. Raster data is exporting in ENVI header file format while vector data can be exported in ESRI shape file. A list of possible parameters for export can be found from drop down menu.
Chapter 2

Drainage Network Preparation

Drainage network preparation is done on a depressionless DEM. It consists of resolving flow directions, calculating upslope area, assigning stream strahler order and extracting sub basins. They are discussed in detail in the upcoming section and shown in Figure No. 2.1. The drainage network extraction is very tedious in a sense that DEMs usually contains features e.g. pits and flat areas. Resolving the flow directions and floating over these locations is very tricky and research are still working on it for at least 25 years.

![Figure 2.1: Processes Menu of TecDEM](image)

Figure 2.1: Processes Menu of TecDEM
2.1 Flow Directions and Link file

The D8 algorithm is the most commonly used and well understood method for resolving flow directions on a topographic surface. It routs flow on each pixel of DEM to possible downward pixel bases upon the lowest neighbor slope. In order to create a D8 flow grid, we first create a depressionless DEM from generated original DEM. This method focuses on centering flow within flat valleys and reducing parallel flow. Flow direction calculation is the first step in the process menu. It is accessed using Flow direction sub menu from Process menu.

The link file is the second step in drainage network preparation. It calculates the linear index for all the pixels where the drainage is flowing.

2.2 Upslope Area

The contributing area refers to the number of pixel contributing flow to a specific stream. These number of pixels are then converted to area in Sq. Km by using DEM resolution. It can be calculated by clicking on the Contributing Area as shown in Figure. No. 2.2.

![Figure 2.2: Area threshold value](image)

2.3 Stream Strahler Orders

In the next step, drainage network of the area is extracted. The critical source area, CSA, is used to threshold the upstream area. The normal value taken in this case is around 1.0 Sq. Km but user can modify this value by entering their own values. By the end of this process, all the streams are vectorized and their respective strahler orders are assigned.

2.4 Sub Basins extraction

The water shed extraction menu is used to extraction sub basins of any desired strahler order. This type of calculations are helpful when we want to analyze our data sets. The threshold of user defined strahler order can be given in a logical range for that data set.
2.5 Plots

Different types of plot are available in TecDEM. User can plot, DEM, extracted drainage network or extracted sub basins. The DEM can be plotted by just clicking on the Digital Elevation Model from Display menu. Similarly, drainage network will be displayed using the drainage network sub menu. It will ask the user to define colors and width of the line segment for different strahler order as shown in figure. no. 2.3.
2.6 Streams Selection

For Stream Profile and Hack Index calculation we need to select specific anomalous streams from our extracted drainage network. It require users expertise about the tectonics of the area and channels of specific interest. These streams can be extracted using extract menu of the plotted drainage network, drainage network or sub basins.
2.6. STREAMS SELECTION

Figure 2.5: Drainage Network Plot using TecDEM

Figure 2.6: Selected Basins Plot using TecDEM
Chapter 3

Analyses

The analyze menu of TecDEM (See Figure No.3.1) consists of three main functions i.e. Stream Profile, Spatial Statistics and Basin Analysis. The user first need to prepare drainage network if already not prepared as mentioned in chapter no. 1 and 2. The available methods are discussed in the following sections.

Figure 3.1: Analyz menu of TecDEM
3.1 Stream Profile Analysis

This analysis consists of three sub functions i.e. identifying knickpoints, concavity and steepness indices and Hack SL index. The first two processes are semi automatic while the last one is fully automatic.

Knickpoints are important tool to understand the landscape response to a base level fall and the corresponding sediment fluxes from rejuvenated catchments. We identified those points on individual stream profiles and hence their spatial distribution is available in map view to see the tectonic behavior. For convenience it is select Knickpoint Selection menu item from Analyze menu. User can add or delete the knickpoints (see Figure No. 3.2).

\[
\frac{dz}{dt} = U - E = U - KA^m S^n
\]  

(3.1)

\[
S = \left(\frac{U}{K}\right)^{1/n} A^{m/n}
\]  

(3.2)

Figure 3.2: Knickpoint selection using TecDEM

Figure 3.3: Selecting Trends with Mouse click and getting the results

The concavity and steepness analyses are powerful tool for neotectonics investigations by analyzing streams passing though a tectonically active region. We take the basic assumption that the study area is under steady state condition. Mathematically we can write that
3.2 Spatial Statistics

\[ S = k_s A^{-\theta} \]  

(3.3)

Where \( k_s \) and \( \theta \) are Steepness and Concavity indices respectively.

TecDEM takes a critical relationship between area and slope profile and analyze concavity and steepness parameters for different stream segments (see Figure No. 3.3). Users have the ability to zoom the profile for better understanding of the area-slope relationship, selected the trend and delete them. Here users can also click on Result Preview to get the final analyzed profile (see Figure No. 3.4).

Hack, J. T. developed an important relationship for understanding stream geometry and formulated stream gradient index or Hack index (see Figure No. 3.5). This index allows meaningful comparisons of channel slope on streams of different size. The change in gradient index values along a stream often corresponds to changes in bedrock. This analysis depends upon the contour interval for index calculation. In TecDEM user can select Hack Index menu item from Analyze menu and will be prompted for contour interval. This value should be in the measurement units similar to DEM. This is a fully automated unsupervised calculation and will be available for all streams.

![Contour Interval Setting](image)

**Figure 3.5:** Hack Index Contour Interval setting in TecDEM

3.2 Spatial Statistics

Four different spatial statistics are available to analyze surface dynamics and drainage system. These parameters are accessed by mouse click as shown in figure no. 3.6. They require one
user parameter i.e. the moving window size which can be entered in pixels and varies from region to region and extent of the study area.

![Figure 3.6: Spatial statistics using TecDEM](image)

**3.3 Basin analysis**

At the moment, TecDEM offer two types of basin analysis i.e. T index or basin tilting and Hypsometric analysis. T index will first perform distance transformation and maximum curvature analysis to identify the basin mid line. This basin mid line can be traced from file menu, remembering that left mouse click will add new point to the traced line and right mouse click will stop the tracing. Similarly, left mouse click can be used to select the main stream for that specific basin and right mouse click to finalize it. Later on, calculate menu will be used to calculate T-Index at the desired length. The default length is 2 km. Similarly, an automatic process can be used to calculate hypsometry of the basins (see figure no. 3.8. On the right hand side, use can click on the desired basin to see it hypsometric curve. If user want to see more than one curve at a time, then he/she must use plot menu. The basin number should be entered in the graphical user input dialog separated by ;. Similarly, statistical moments of single of multiple basins can be displayed.
3.3. BASIN ANALYSIS

Figure 3.7: Basin asymmetry in TecDEM

Figure 3.8: Basin Hypsometry in TecDEM
Chapter 4

Reports

User may wish to generate different reports and images when the desired analysis are complete. At this moment user is allowed to generate full analyzed and tabulated reports, plot the stream profile analysis and Hack Index results.

4.1 Detailed and Tabulated

The detailed and complete tabulated reports menu items in Reports menu will generated the results as shown in Figure No. 4.1.

4.2 Profile Plots

The analyzed stream profiles using Stream Profile Analysis and Hack Index Analysis can be plotted using Reports menu. The Stream Profile analysis will be the same as shown in Section No. 3.2. The Hack Index results can be edited within MATLAB and looks as shown in Figure No. 4.2.
4.3 Map Plots

A list of all the possible map plots is included in the sub menu. Just click on the item for which you want to display a map.

4.4 Citations

If you need to publish your results, then cite it using following reference.

